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Часть V 
 

 
 
 
 
 
Изменение проектов 
 
Вы можете быстро дополнять проекты путем дублирования и копирования 
существующих объектов. Также имеется возможность комбинировать проекты, 
вставляя содержимое одного файла в другой. 
 
Комбинирование и изменение последовательности объектов 
 
В этом разделе описывается, каким образом можно комбинировать объекты и проекты 
путем копирования и вставки, дублирования и вставки целых проектов и их элементов. 
Здесь же объясняется, как группировать и разгруппировать объекты, а также назначать 
последовательность объектов различными способами, включая функцию Color Film. 
Рассматривается также функция автоматического установление последовательности 
всего проекта. 
Подробнее см. в главе Комбинирование и изменение последовательности объектов 
 
Расположение и трансформация объектов 
 
В этом разделе описывается, как позиционировать и выравнивать объекты как 
интерактивными, так и цифровыми способами. Также рассматриваются способы 
изменения размеров, вращения и перекоса объектов. Кроме того, описываются 
различные способы перевода объектов в зеркальное отображение. 
Подробнее см. в главе Расположение и трансформация объектов. 
 
Изменение формы и правка объектов 
 
В этом разделе объясняется, как изменять форму объектов контрольными точками, 
изменять форму окружностей, устанавливать угол наклона стежков – включая сложные 
углы наклона – и изменять точки входа и выхода. См. также раздел Правка 
вышиваемых текстов. 
Подробнее см. в главе  Изменение формы и правка объектов 
 
 
Редактирование стежков 
 
В этом разделе объясняется, как выбирать и редактировать стежки. 
Подробнее см. в главе Редактирование стежков 
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Глава 21  
Комбинирование и изменение 
последовательности объектов 
 
BERNINA Embroidery Software позволяет легко создавать комбинации 
проектов и элементов проекта путем вставки содержания одного файла в 
другой. Вы можете также быстро добавлять к проектам существующие 
объекты путем их копирования или дублирования. Объединение в группу 
выделенных объектов или целых проектов используется для совместного 
перемещения, изменения размеров или трансформирования. Объекты 
вышивки в проекте образуют "последовательность вышивания". 
Первоначально объекты вышиваются в том порядке, в котором они были 
созданы. Однако имеется много способов изменения последовательности 
вышивания. Например, можно изменить положение выделенного объекта, 
вырезав его и вставив в другое место последовательности. Имеются также возможности 
выбора последовательности объектов способом "As Selected" ("Последовательность в порядке 
выделения") или как "Color Blocks" ("Цветные блоки"). Вы можете также изменить 
последовательность объектов, используя инструмент Color Film. 
Функция Stitch Sequence (Последовательность вышивания) улучшает качество и 
эффективность вышивания, сводя к минимуму количество перезаправки пялец, замены 
цветных ниток и обрезки ниток.  Все существующие перекрытия сохраняются при этой 
операции. 
В этом разделе описывается, каким образом можно комбинировать объекты и проекты путем 
копирования и вставки, дублирования и вставки целых проектов и их элементов. Здесь же 
объясняется, как группировать и разгруппировать объекты, а также назначать 
последовательность объектов различными способами, включая функцию Color Film. 
Рассматривается также функция автоматического установление последовательности всего 
проекта. 
 

Комбинирование объектов 
 
Проект или объекты проекта можно копировать или вырезать и загружать в буфер обмена Windows для 
временного сохранения. Содержимое буфера обмена может быть вставлено любое число раз в один и тот 
же или в другой проект, до тех пор. Кроме того, объекты можно клонировать или дублировать без 
копирования в буфер обмена. См. также Выбор объектов. 
 
Копирование и вставка объектов 

 
Нажмите кнопку Copy (панель General), чтобы копировать выделенные объекты в буфер обмена. 
 
 
Нажмите кнопку Paste (панель General), чтобы вставить скопированные объекты в проект.   
 

Вы можете копировать объекты, чтобы создавать многократно воспроизводимые идентичные объекты или 
вставлять объекты из других проектов. См. также Установление последовательности объектов функцией 
Color Film. 
 
Примечание: Вы можете также удалять объекты из проекта, пользуясь командой Cut (Вырезать), и 
вставлять их обратно. Команды Cut и Paste изменяют последовательность вышивания в проекте. 
Подробнее см. в разделе Изменение последовательности вышивания объектов командами Cut и Paste.  
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Как копировать и вставлять объекты 
1 Выделите объект (или объекты) для копирования. 
2 Нажмите кнопку Copy (Копировать). 
 Выделенный объект будет скопирован в буфер обмена. 
3 Перейдите к позиции в последовательности вышивания, в которую вы хотите вставить объект. 

Подробнее см. в разделе Обход по стежкам. Вы можете вставить объект между другими объектами в 
последовательности вышивания. 

4 Нажмите кнопку Paste (Вставить). 

       
Лепестки скопированы и вставлены 

 
Примечание: Объект будет вставлен точно в верхнюю часть оригинального объекта. Щелкните 
мышью и перетащите объект перед отменой выделения. Объект будет оставаться в буфере обмена и 
может быть неоднократно вставлен до тех пор, пока не последует следующая команда Copy 
(Копировать) или Cut (Вырезать).  
 
Внимание: Убедитесь в том, что имеется только одна копия объекта в одной и той же позиции. Если 
объект вставлен дважды в одну и ту же позицию, то он будет вышит дважды. 

        
Дублирование объектов 
 
Выберите команду Duplicate (меню Edit), чтобы дублировать выделенные объекты. 
 
Предпочтительнее дублировать объекты, чем копировать. При дублировании объекта он не копируется в 
буфер обмена. Этим вы сохраняете буфер обмена для вырезки или копирования других объектов. См. 
также Установление последовательности объектов функцией Color Film. 
 

     
Как дублировать объекты 
1 Перейдите к позиции в последовательности вышивания, в которую вы хотите поместить объект. 

Подробнее см. в разделе Обход по стежкам. 
 Вы можете поместить объект между другими объектами в последовательности вышивания. 
2 Выделите объект (или объекты) для дублирования. 
3 Выберите Edit > Duplicate. 
 Дублированный объект помещен непосредственно в верхней части оригинального объекта в 

назначенной позиции последовательности вышивания. Не забудьте щелкнуть мышью и перетащить 
объект перед отменой выделения. 
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Щелкните правой 
кнопкой мыши 
 
Перетащите объект  

 
Клонирование объектов 

 
Для выбора и клонирования объектов используйте  
инструмент Select Object (панель Design). 
 

Функция Quick Clone позволяет быстро дублировать выбранные объекты  перетаскиванием в новое 
положение нажатой правой кнопкой мыши.  
 
Как клонировать объекты 
1  Выделите объект/ы. 
2  Удерживая нажатой правую кнопку мыши перетащите объект/ы в новое положение. 

Контуры объекта/ов станут черными. У указателя мыши появится символ [+]. 

 
Совет: Для точного позиционирования удерживайте нажатой клавишу Ctrl для перетаскивании вдоль 
оси X или Y. 

3  Отпустите кнопку мыши. 
В этой точке будет создан дубликат объекта/ов. 
Совет: Клонируйте этим же способом объекты в другом окне. Идентичная копия выделения создается 
в тех же координатах, что и в первом окне, независимо от того, в каком месте вы отпустите кнопку 
мыши.  

Комбинирование проектов 
 
Для комбинирования проектов выберите команду Insert Design (меню File). 
 
BERNINA Embroidery Software позволяет вставить один проект в другой. Два или больше проектов могут 
быть затем сохранены в комбинированном проекте. 
Если вы вставляете один проект в другой, две цветовые палитры комбинируются. Цвета с одними и теми 
же значениями RGB автоматически идентифицируются как имеющие один и тот же цвет ниток. Если вы 
хотите сохранить их как отдельные цвета, то вам нужно изменить один или другой цвет перед слиянием. 

      
Как комбинировать проекты 
1 Откройте первый проект. 
2 Перейдите к позиции в последовательности вышивания, в которую вы хотите вставить проект. 

Подробнее см. в разделе Обход по стежкам.  
3 Выберите File (Файл) > Insert Design (Вставить Проект). 
 Откроется диалоговое окно Open. 
4 Из открывшегося списка Look In выберите папку, в которой сохраняется проект, который вы хотите 

вставить, и выберите требуемый формат из списка Files of type. 
5 Выберите файл с нужным вам проектом и нажмите Open. 
 Проект будет вставлен в текущую позицию иглы. 
6  Переместите второй проект в нужное вам положение. 
 Подробнее см. в разделе Позиционирование объектов перетаскиванием мышью. 
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Вставленные вами 
проекты 
скомбинированы в 
единый проект 

 
Совет: Чтобы гарантировать, что все объекты вставляемого проекта будут связаны между собой, 
сгруппируйте проект во время работы с ним. Подробнее см. в разделе Группирование объектов. 

7  Сохраните комбинированный проект под оригинальным или измененным именем. 
 

     
 
Группировка и разгруппировка объектов 
Вы можете объединить в группу выбранные объекты или весь проект, чтобы сохранять связи между 
объектами во время перемещения, изменения размеров и трансформации. BERNINA Embroidery Software 
различает понятия "разгруппирование" объектов и "разбивка" объектов. В общем случае объекты, которые 
были вами объединены в группу, для оцифровки должны быть "разгруппированы", чтобы получить доступ 
к компонентам объектов. Если вам нужно получить доступ к объектам, которые были сгруппированы во 
время системных операций, - например, при генерировании объекта открытой аппликации, - вам 
потребуется разбить объекты. 
 
Примечание: По умолчанию проекты автоматически группируются при открытии или вставке в другой 
проект. Подробнее см. в разделе Настройка других общих опций. 
 
Группировка объектов 

 
Щелкните по значку Group (панель Arrange), чтобы сгруппировать выделенные объекты. 
 
 

Вы можете объединить в группу выбранные объекты или весь проект, чтобы сохранять связи между 
объектами во время перемещения, изменения размеров и трансформации. Объединение в группу 
выделенных объектов или целых проектов используется для совместного перемещения, изменения 
размеров или трансформирования.  
 
Как сгруппировать объекты 
1  Выберите объекты для объединения в группу. 
2  Нажмите кнопку Group (Объединить в группу)   

или нажмите Ctrl + G.  
 

Выделение, перемещение или  
трансформирование сгруппированных  

объектов как единого объекта 
 
 
Выбранные объекты объединяются в группу. Группа может быть выделена, перемещена, изменена по 
размеру как единый объект. См. также разделы Расположение и трансформация объектов и Изменение 
формы и правка объектов. 
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Разгруппирование объектов 

 
Щелкните по значку Ungroup (панель Arrange), чтобы разгруппировать выделенные объекты. 
 
 

Если вы завершили изменения в группе, вы можете разгруппировать их и работать индивидуально с 
каждым объектом. 
 
 
Примечание: Вам нужно разгруппировать объекты, перед тем как устанавливать параметры вышивания в 
любом из индивидуальных объектов в группе. 
 
Как разгруппировать объекты 
1  Выберите группу объектов. 
2  Нажмите кнопку Ungroup (Разгруппировать). 
 

Разгруппированные  
объекты можно выделять  

индивидуально 
 

Объекты будут разгруппированы, и входившие в группу объекты можно будет выделять 
индивидуально. 

 
Разбивка объектов на компоненты 
 

Используйте инструмент Break Apart (панель Edit ), чтобы разделить монограммы, аппликации, тексты 
и элементы "черной вышивки" на отдельные компоненты. 
 

Инструмент Break Apart позволяет разбить объекты Advanced Applique на отдельные компоненты. 
Эта команда может быть также использована для монограмм, аппликаций, текстов и элементов "черной 
вышивки". Воздействие на эти объекты аналогично операции разгруппировки. 
 
Примечание: При сохранении в предыдущей версии ПО монограммы, аппликации, текстовых объектов, 
объектов "черной вышивки" они могут быть подвергнуты процедуре Break Apart по умолчанию. 
 
 
Как разделять объекты на компоненты 
 
1  Выберите объект, который вы хотите разделить - 

объект открытой аппликации, автоаппликации, текст 
или "черную вышивку". 
Команда Break Apart активирована.  

 
 
 
 
 
2  Щелкните по значку Break Apart или выберите Arrange 

> Break Apart. 
 

Объект будет разбит на исходные (первичные) 
компоненты вместо сгенерированного (вторичного) 
объекта.  

 
 
 
 
 
Эта операция разгруппирует открытый объект аппликации 
в группы компонентов – исходные (первичные) объекты, из 
которых были сгенерированы (вторичные) объекты. Она 
также создает объект авто-аппликации из каждого куска 
ткани в проекте. 
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Они не будут вышиваться. См. также раздел 
Оцифровывание для аппликаций. 
Эта операция разгруппирует объекты монограммы на 
составные группы компонентов – текстовый объект, 
орнаменты (каждый орнамент остается сгруппированным) и 
бордюры (также сгруппированные). См. также раздел 
Создание монограмм. 
Совет: Для модификации индивидуальных объектов, - 
например изменения последовательности вышивания 
бордюров монограммы, - используйте инструмент Color Film, 
чтобы разгруппировать объекты и изменить 
последовательность. 
 
 
 

Изменение последовательности вышивания объектов 
 
Объекты вышивки в проекте образуют последовательность вышивания. Первоначально объекты 
вышиваются в том порядке, в котором они создаются. Вы можете изменить положение выделенного 
объекта, вырезав его и затем вставив где-либо в последовательности. Имеются также возможности 
выбора последовательности объектов способом "As Selected" ("Последовательность в порядке 
выделения") или как "Color Blocks" ("Цветные блоки"). Вы можете также изменить последовательность 
объектов, используя инструмент Color Film. См. также Установление последовательности объектов 
функцией Color Film. 
 
Изменение последовательности объектов вырезкой и вставкой 

 
Нажмите Cut (панель General), чтобы вырезать объект или объекты с помещение в буфер 
обмена. 
 
Нажмите Paste (панель General), чтобы вставить скопированные объекты в проект.  
 
Вы можете изменить последовательность объектов путем вырезания объекта из проекта и 

вставить его в другое место последовательности. Это не внесет изменений в физическое расположение 
объекта. 
 
Как изменять последовательность объектов вырезкой и вставкой 
1 Выделите объект (или объекты) для изменения последовательности. 
2 Нажмите кнопку Cut (Вырезать). 
 Выделенный объект будет удален из проекта и помещен в буфер обмена. 
 
 

     
Неправильная     Выделенный и вырезанный 
последовательность  объект будет изменен 

 
3 Перейдите к точке в последовательности вышивания, в которую вы хотите поместить объект. 

Подробнее см. в разделе Обход по стежкам. 
 Вы можете вставить объект между другими объектами в последовательности или "вмонтировать" 

вырезанный объект внутри другого объекта. 
 Если текущее положение маркера иглы находится в конце проекта, объект будет вставлен в конце 

последовательности. 
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4 Нажмите кнопку Paste (Вставить). 

     
Перейдите к концу проекта  Вставьте объект  

 
 Объект будет вставлен в конец проекта. 
 
 Примечание: Объект будет оставаться в буфере обмена и может быть неоднократно вставлен до тех 

пор, пока не последует следующая команда Copy (Копировать) или Cut (Вырезать).  
 
Изменение последовательности выделенных объектов 
 

Выберите команду Sequence As Selected (меню Arrange), чтобы изменить последовательность 
выделенных объектов. 
 

Вы можете изменить последовательность объектов путем их выделения в порядке требуемой 
последовательности вышивания. 
 
Как изменить последовательность выделенных объектов 
1 Выделите первый объект в диапазоне объектов, последовательность которых вы хотите изменить. 
2 Удерживая нажатой клавишу Ctrl, последовательно выберите объекты в порядке изменения 

последовательности.   
 

 Примечание: Выбирайте каждый объект в том порядке, в котором вы хотите их вышивать. 
3 Когда объекты еще остаются выделенными, выберите команду Arrange (Расположение) > Sequence As 

Selected (Последовательность в порядке выделения). 
 Теперь последовательность объектов будет соответствующей порядку их выделения  справа от 

первого выделенного объекта. См. также Установление последовательности объектов функцией Color 
Film. 

 

       
   Неправильная     Правильная  
последовательность   последовательность 

Изменение последовательности объектов по цвету 
 
Выберите команду Sequence By Color (меню Arrange), чтобы изменить последовательность объектов по 
цвету. 
 

Вы можете изменить последовательность объектов по цвету. Таким образом, вы уменьшите количество 
цветовых переходов в проекте.  См. также Установление последовательности объектов функцией Color 
Film. 
 
Как изменить последовательность объектов по цвету 
1 Выберите объекты для изменения последовательности. 
2 Выберите команду Arrange > Sequence By Color. 
 Откроется диалоговое окно Sequence By Color (Последовательность по цвету) со списком цветов в 

выбранных объектах. 

       
3 Выберите цвет и нажмите Move Up (Переместить вверх) или Move Down (Переместить 

вниз), чтобы изменить его положение в последовательности.  
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4 Нажмите кнопку ОК. 

     
Черный цвет первый   Черный цвет последний 

 
Изменение последовательности объектов в начале или конце 
 
Вы можете изменить последовательность объектов, выделив их и расположив в начале или конце 
последовательности вышивания. См. также Установление последовательности объектов функцией Color 
Film. 
 
Как изменить последовательность объектов в начале или конце 
◄ Выделите объект. 
◄ Выберите команду Arrange > Sequence to Start. 
 Последовательность вышивания проекта изменяется при размещении выделенного объекта в начало  
      последовательности. 
◄ Выберите команду Arrange > Sequence to End. 
 Последовательность вышивания проекта изменяется при размещении выделенного объекта в конец  
      последовательности. 
 
Изменение последовательности объектов инструментом Color Film 
 
Выберите команду Sequence to Start (меню Arrange), чтобы поместить выделенный объект в начало 
последовательности вышивания.  
Выберите команду Sequence to End (меню Arrange), чтобы изменить последовательность выделенного 
объекта в конце последовательности вышивания.  

 
Вы можете изменить последовательность объектов путем изменения их положения в окне Color 
Film. 
 
Щелкните по кнопке Show Individual Objects (панель Color Film), чтобы просмотреть индивидуальные 
объекты в порядке последовательности вышивания.  Перетаскивайте значки объектов для изменения 
последовательности.  
 
Выберите команду Sequence As Selected (панель Color Film), чтобы изменить последовательность 
выделенных объектов. 
 
Выберите команду Sequence By Color (панель Color Film , чтобы изменить последовательность 
объектов по цвету. 
 
Выберите команду Sequence to Start (нанель Color Film), чтобы поместить выделенный объект в начало 
последовательности вышивания.  

 
Выберите команду Sequence to End (нанель Color Film), чтобы поместить выделенный объект в конец 
последовательности вышивания.  
 

Проекты создаются из индивидуальных вышивальных "объектов", сгруппированных функцией "color block". 
Они указываются в порядке вышивания в списке Color Film. Используйте эту возможность для 
оптимизации своего проекта путем вырезания, копирования, вставки, дублирования, удаления и 
изменения последовательности выбранных цветных блоков. В общем случае вы должны стремится к 
сохранению блоков с одним и тем же цветом а общей последовательности, чтобы свести к минимуму 
количество изменений цвета, обрезки ниток и перемещения пялец. После оптимизации цветовой 
последовательности вы сможете оптимизировать свой проект, проверив последовательность вышивания 
отдельных объектов. См. также раздел Просмотр и выделение цветных блоков. 
 
Примечание: Возможны случаи, при которых может потребоваться разбивать цвета, в особенности, если 
один из объектов находится около контура, поскольку контуры требуется вышивать поверх заполнения.  
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Щелкните по 
цветному блоку 
удерживая кнопку 

Перетащите  цветной 
блок в новое 
положение 

Последовательные 
объекты одного цвета 
образуют единый 
цветной блок 

Все объекты, 
входящие в цветные 

блоки, показываются в 
последовательности 

вышивания

Используйте 
всплывающее меню для 
вырезки, копирования, 

вставки объектов

Как изменить последовательность объектов инструментом Color Film 
• Нажмите кнопку Color Film. 

Откроется диалоговое окно Color Film, отображающее все цветные блоки в проекте в порядке 
последовательности вышивания. 

 
• Перетащите выделенные объекты, чтобы изменить их расположение в последовательности 

вышивания  

     
Примечание: Функция Color Film синхронизирована с 
окном проекта. Она динамически обновляется в то 
время, когда вы выбираете, изменяете или удаляете 
объекты или создаете новый объект.  
 
◄ Щелкните по переключающей кнопке Show 

Individual Objects (Показать индивидуальные 
объекты), чтобы просмотреть индивидуальные 
объекты. Все объекты в пределах каждого 
цветного блока показываются в 
последовательности вышивания. 

 
 
◄ При необходимости используйте список для 

перетаскивания значков объектов и изменения 
последовательности. 
◄ Для выделения нескольких идущих подряд объектов 

удерживайте нажатой клавишу Shift. 
 
◄ Для выделения нескольких объектов удерживайте нажатой 

клавишу Ctrl. 
◄ Щелкните правой кнопкой мыши по списку, чтобы 

вызвать всплывающее меню. Используйте его при 
необходимости для вырезания, копирования или 
вставки объектов. 

 
◄ Используйте кнопку команды Sequence для изменения положения выбранных цветных блоков или 

индивидуальных объектов в последовательности вышивания.  
Каждая команда Sequence выполняет ту же функцию, что и идентичный пункт в меню Arrange, т.е. 
щелчок по значку Sequence By Color, если он активирован, вызывает открытие диалогового окна 
Sequence By Color. См. также раздел Установление последовательности объектов. 

 
 
Автоматическая последовательность вышивания всего проекта 
Щелкните по  Stitch Sequence (иеню Arrange) для автоматического выбора последовательности вышивания, 
чтобы свести к минимуму число перезаправок пялец, обрезок нитки и изменений цветов.   
 
Функция Stitch Sequence (Последовательность вышивания) улучшает качество и эффективность 
вышивания, сводя к минимуму количество перезаправки пялец, замены цветных ниток и обрезки ниток.  
При этой операции сохраняются все существующие перекрытия. Система анализирует проект и 
пересчитывает: 
◄ перезаправки пялец (если требуется больше одного раза) 
◄ замену цветных ниток (общее число в текущем окне проекта) и 
◄ объекты, которые вышли за контуры пялец (если таковые имеются). 



Глава 21: Комбинирование и изменение последовательности объектов 

BERNINA® Designer Plus Версия 5 301

 
Объединенные в группу объекты при операции Stitch Sequence не 
разгруппируются, но объектам разного цвета назначается 
оптимальная последовательности независимо от группировки. 
Однако монограммы и объекты открытой аппликации 
обрабатываются как отдельные объекты. Другими словами, их 
внутренняя последовательность не изменяется до тех пор, пока 
командой Break Apart они не будут разбиты. См. также Разбивка 
объектов на компоненты. 
 
Как назначить автоматическую последовательность всему 
проекту  
1  Откройте или создайте проект. 
 
 
2  Выберите Arrange > Stitch Sequence. 

Система анализирует все выбранные объекты и рассчитывает оптимальное число перезаправок 
пялец, замен цветов и обрезок ниток. 

 

 
 
Примечание: Если ваш проект не размещается в текущих 
пяльцах, вы будете об этом предупреждены.  Вы сможете 
выбрать более крупные пяльцы или  использовать 
перезаправку. См. также Закрепление в пяльцах крупных 
проектов.  
 
3  Щелчком по кнопке Yes подтвердите предложенную 

оптимальную последовательность. 
 
Примечание: Командой Undo можно отменить изменение 
последовательности вышивания. 
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Глава 22  
 

 

Расположение и 
трансформация объектов 
 
 
BERNINA Embroidery Software позволяет располагать и 
трансформировать объекты различными способами, как интерактивной, 
так и цифровой техникой. Позиционировать объекты можно 
перетаскиванием мышью, клавишами со стрелками или изменением 
свойств объекта. Для выравнивания объектов относительно друг друга 
имеются различные специальные инструменты. 
Изменять размеры объектов можно непосредственно на экране или 
заданием точных размеров или процентного изменения. Поворот, 
изменение наклона и зеркальное отображение объектов производится 
такими же средствами. 
Специальные инструменты позволяют дублировать и 
трансформировать вышивальные объекты, а также переводить их в 
зеркальное отображение и поворачивать по центральным осям.  
В этом разделе описывается, как позиционировать и выравнивать объекты как интерактивными, 
так и цифровыми способами. Также рассматриваются способы изменения размеров, вращения 
и перекоса объектов. Кроме того, описываются различные способы перевода объектов в 
зеркальное отображение. 

 

Позиционирование объектов 
Вы можете позиционировать объекты в окне проекта различными стандартными методами операционной 
системы MS Windows®, а том числе перетаскиванием мышью, а также клавишами со стрелками для 
"подталкивания" в требуемое положение. Вы можете также задавать точные координаты объекта, 
используя свойства объекта. 
 
Позиционирование объектов перетаскиванием мышью 
Наиболее простым способом перемещения объекта в вашем проекте является перетаскивание его 
мышью. Используйте клавиши со стрелками для "подталкивания" объекта к нужной позиции. 
 
Как позиционировать объекты перетаскиванием мышью 
1  Выберите объект/ы для перемещения. 
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2  Перетащите мышью объект в новое положение. 
 
 
 
Курсор в виде перекрести в центре объекта 
 
 
 
 
 

3  Для более точного позиционирования нажимайте клавиши со стрелками, чтобы "подтолкнуть" объект к 
требуемой позиции. 
Совет: Увеличьте масштаб изображения, чтобы было легче выполнять малейшие перемещения. 
Размеры объекта на экране изменяются в зависимости от текущего масштаба. Чем больше масштаб, 
тем на меньшее расстояние можно перемещать объект. 

 
Позиционирование объектов с использованием свойств объекта 
Вы можете позиционировать выбранные объекты по отношению к центру проекта вводом координат X:Y в 
диалоговом окне Object Properties (Выбор объекта). 
 
Как позиционировать объекты с использованием свойств объекта 
1  Выберите объект/ы для перемещения. 
2  Дважды щелкните по проекту, чтобы открыть диалоговое окно Object Properties, и выберите закладку 

General. 
 

      
 

                                 Введите новые координаты 
3  В полях Position введите новые координаты объекта. 
4  Нажмите кнопку Apply. 
 Центр объекта переместится в точку ч назначенными вами координатами. 
 
Выравнивание объектов 

 
Для выбора объекта используйте инструмент Select Object (Выбрать объект) на панели Design. 
 
 

Щелкните по значку Align Left Vertical (Выровнять слева по вертикали) на панели Arrange, чтобы 
выровнять объекты по их левым сторонам. 
 
Щелкните по значку Align Centers Vertical (Выровнять средние линии по вертикали) на панели 
Arrange, чтобы выровнять объекты по их средним линиям. 
 
Щелкните по значку Align Right Vertical (Выровнять справа по вертикали) на панели Arrange, 
чтобы выровнять объекты по их правым сторонам. 
 
Щелкните по значку Align Top Horizontal (Выровнять верхние стороны по горизонтали) на панели 
Arrange, чтобы выровнять объекты по их верхним сторонам. 
 
Щелкните по значку Align Centers Horizontal (Выровнять средние линии по горизонтали) на 
панели Arrange, чтобы выровнять объекты по их средним линиям. 
 
Щелкните по значку Align Bottom (Выровнять нижние стороны) на панели Arrange, чтобы 
выровнять объекты по их нижним сторонам. 
 
Щелкните по значку Align Centers (Выровнять центры) на панели Arrange, чтобы выровнять 
выделенные объекты по их центрам. 
 
BERNINA Embroidery Software позволяет выравнивать объекты, чтобы позиционировать их по 

отношению друг к другу. Вы можете выравнивать выбранный объект по левому, правому, верхнему или 
нижнему краю или по центру.  
Как выравнивать объекты 
1  Выберите объекты, которые вы хотите выровнять. 
2  Выберите объекты, которые вы хотите выровнять совместно. 
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Примечание: Объекты выравниваются с последним 
выбранным объектом. Если мы выделяем все объекты 
проекта клавишами Ctrl+A или командой "Выделить все", 
объекты выравниваются по последнему объекту 
последовательности. 

Выравнивание по центрам 
 

3  Щелкните по одному из значков выравнивания на 
панели Arrange (Расположение). 

 
 
 
 
 
 
 

Выравнивание по                  Выравнивание  
нижнему краю                        по левому краю. 

 

Изменение размеров объектов 
 
Вы можете изменять размеры объектов непосредственно на экране или заданием точных размеров или 
процентного изменения. 
При изменении размеров объекта изменяется количество стежков для сохранения интервала между 
стежками. 
 
Примечание: Возможность изменения размера и качество вышивки  в конечном счете зависит от 
формата первоисточника – ART Grade A, ART Grade B, ART Grade C или ART Grade D. Только проекты в 
"родном" формате ART Grade A содержат полный набор информации, требуемой для 100%-ного 
совершенства масштабирования и трансформации. Подробнее см. в разделе Форматы проектов вышивки. 
 
Изменение размеров объектов инструментом Scale by 20% Down/Up 
 

 Щелкните по значку Scale by 20% Down/Up (панель Edit), чтобы уменьшить размеры объектов  
на 20 %. Щелкните правой кнопкой мыши, чтобы увеличить размеры объектов на 20 %  

 
Используйте эту технику, если вы хотите быстро выполнить изменения, которые не требуют особой 
точности. 

            
уменьшение на 20 % оригинальный размер  увеличение на 20 % 

 
Как изменять размеры объектов инструментом Scale by 20% Down/Up 
1  Выделите объект/ы. 

Совет: См. раздел Выбор нескольких последовательно расположенных объектов для быстрого 
выделения нескольких или всех объектов проекта. 

2  Щелкните по значку Scale by 20% Down/Up. 
◄ Щелкните левой кнопкой мыши, чтобы уменьшить проект на 20 %. 
◄ Щелкните правой кнопкой мыши, чтобы увеличить проект на 20 %.  
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Изменение размеров объектов перетаскиванием мышью 
 
Вы можете изменить высоту и ширину объекта или пропорционально изменять размеры объекта, 
используя маркеры – манипуляторы выделения. Изменяйте объекты индивидуально или выберите 
несколько объектов для одновременного изменения. 
 
Как изменять размеры объектов перетаскиванием мышью 
1  Выберите объект/ы для изменения размеров. 
 Вокруг выделенного объекта появятся восемь меток – манипуляторов выделения. 
2  Перетащите мышью манипулятор, чтобы изменить размер объекта 

 
 
◄    Для пропорционального изменения высоты и   

    ширины используйте угловые маркеры 
 
Совет: По умолчанию размеры объектов изменяются 
пропорционально. Для изменения размера только по 
вертикали или горизонтально удерживайте при 
перетаскивании клавишу Ctrl.         
 Перетащить    Shift + Перетащить 

пропорциональное  пропорциональное  
                      изменение размеров   изменение размеров 

                      относительно центра 
 

 
◄ Для изменения высоты используйте верхний средний 

или нижний средний маркеры. 
 Изменение по вертикали 

 
 

 
 

 
 

◄ Для изменения ширины используйте средние боковые 
маркеры. 

Изменение по горизонтали 
 
 
 
Совет: Для изменения размеров относительно 
центра во время перетаскивания маркера 
удерживайте нажатой клавишу Shift. 
 
           

 
 
 
Изменения по вертикали       Изменения по горизонтали 
в обоих направлениях       в обоих направлениях 

 
Совет: Для изменения размеров относительно центра во время перетаскивания маркера удерживайте 
нажатой клавишу Shift. 

 

Изменение размеров объектов с использованием свойств объекта 
Вы можете изменять высоту и ширину выбранных объектов или всего проекта, используя свойства 
объекта. 
 

Внимание: Если вы изменяете проект  или „expanded“ дизайн больше чем на 5 %, изменения плотности 
стежков может повлиять на качество вышивки проекта. См. также Форматы проектов вышивки. 
 

Как изменять размеры объектов с использованием свойств объекта 
1  Выберите объект/ы для изменения размеров. 
2  Дважды щелкните или щелкните правой кнопкой мыши по проекту, чтобы открыть диалоговое окно 

Object Properties, и выберите закладку General. 
3  На панели Dimensions (Размеры) измените размеры по своему выбору. Альтернативно: 

◄ введите точные значения высоты (Height) и ширины (Width) или  
◄ введите новые значения высоты и ширины в качестве процентного отношения к текущим 

размерам. 
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Введите размеры  в виде 

абсолютных или процентных 
величинах 

 
4  Нажмите кнопку Apply. 

    
150%-ное   оригинальный  80%-ное уменьшение 
увеличение  размер    высоты 
высоты        140%-ное увеличение ширины 
 
Примечание: После изменения размеров размеры нового объекта устанавливаются на 100 %.  

Вращение объектов 
Вы можете поворачивать объекты непосредственно на экране или назначив угол поворота. 
 
Вращение объектов перетаскиванием мышью 
При выделении объекта на его крайних точках появляются метки – манипуляторы выделения. Если вы 
щелкните по объекту еще раз, то эти метки преобразуются в маркеры вращения. 
 
Как поворачивать объекты перетаскиванием мышью 
1  Выберите объект/ы для поворота. 

Вокруг выделенного объекта появятся восемь меток – манипуляторов выделения. 
 
2  Щелкните по объекту еще раз. 
 На углах объекта появятся маркеры вращения, а в его центре отобразится местоположение анкера. 
       маркер наклона 

      
маркер вращения  
      
местоположение анкера 
 
 
 
 
 
 

первым щелчком   после второго щелчка 
отображаются    появляются маркеры вращения 
маркеры выделения 

 Внимание: Если второй щелчок последует за первым слишком быстро, откроется диалоговое окно 
Object Properties. 

3  При необходимости перетащите анкер вращения в другое положение. 
4  Щелкните по маркеру вращения и перетащите его по часовой стрелке или против часовой стрелки. Во 

время поворота появляется контур и перекрестие. 

      
Перетащите угол,   Перетащите анкера  Перетащите угол, чтобы  
чтобы повернуть   местоположение   повернуть объект вокруг анкера. 
объект вокруг анкера. 
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Вращение объектов инструментом Rotate CCW/CW 
 
Щелкните левой кнопкой/ правой кнопкой по значку Rotate 45 ° CCW/CW (панель Edit), чтобы 
повернуть объект или проект на 45° в любом направлении. 
 

Используйте инструмент Rotate CCW/CW (Поворот против часовой стрелке/по часовой стрелке), чтобы 
поворачивать объекты на 45° в любом направлении. 
 
Как вращать объекты инструментом Rotate CCW/CW 
1  Выберите один или несколько объектов инструментом Select Object (Выбор объекта). 
2  Щелкните по значку Rotate CCW/CW на панели инструментов.  

◄ Щелчок правой кнопкой – поворот на 45° по часовой стрелке. 
◄ Щелчок левой кнопкой – поворот на 45° против часовой стрелке. 

 
Вращение объектов с использованием свойств объекта 
 
Вы можете повернуть выбранные объекты путем ввода точного значения угла поворота в диалоговом окне 
Object Properties. 
 
Как вращать объекты с использованием свойств объекта 
1  Выберите объект/ы для поворота. 
2  Дважды щелкните /щелкните правой кнопкой по проекту, чтобы открыть диалоговое окно Object 

Properties, и выберите закладку General. 
3  В поле Rotate By (Повернуть на), введите требуемое вам значение угла поворота. 
4  Нажмите кнопку Apply. 

  
 
Введите угол поворота 
 
 
 

Перекос объектов 
Вы можете придавать объектам нужный угол перекоса непосредственно на экране или путем ввода угла 
перекоса в диалоговом окне Object Properties. 
 
Перекос объектов перетаскиванием мышью 
Вы можете перекосить объект относительно горизонтальной 
линии, щелкнув по маркеру перекоса и перетащим его на 
требуемый угол. 

Перекос объекта  
перетаскиванием мышью 

Как перекосить объекты перетаскиванием мышью 
1  Выберите объект/ы для перекоса. Вокруг выделенного 

объекта появятся восемь меток – маркеров выделения. 
 
2  Щелкните по объекту еще раз. 
 Вокруг объекта появятся маркеры поворота и перекоса. 

Маркеры перекоса имеют форму ромба и появляются в 
средних точках верхнего и нижнего края объекта. 
 
Внимание: Если второй щелчок последует за первым 
слишком быстро, откроется диалоговое окно Object 
Properties. 

 
3  Перетащите маркер перекоса влево или вправо. 
 Объект будет перекошен в горизонтальном направлении. Контур и 

перекрестие покажут изменение формы объекта. 
Перетащите маркер перекоса  

влево или вправо. 
 

Перекос объектов с использованием свойств объекта 
Вы можете перекашивать выбранные объекты путем ввода точного значения угла перекоса в диалоговом 
окне Object Properties. 
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Перекос на 30°  
с использованием  свойств объекта 
 
 
 
 
Как перекашивать объекты с использованием свойств объекта 
1  Выберите объект/ы для перекоса. 
2  Дважды щелкните или щелкните правой копкой по объекту, чтобы открыть диалоговое окно Object 

Properties, и выберите закладку General. 
3  В поле Skew By (Перекос на), введите требуемое вам значение угла перекоса. 
4  Нажмите кнопку ОК. 

 
 
 
Введите угол перекоса 
 

 

Перевод объектов в зеркальное отображение 
 
Вы можете зеркально отображать объекты, переворачивая их по горизонтали 
или по вертикали, используя инструменты Mirror в диалоговом окне Object 
Properties (Свойства объекта). Специальные инструменты позволяют 
дублировать и трансформировать вышивальные объекты, а также 
переводить их в зеркальное отображение и поворачивать по центральным 
осям.  
 
Перевод объектов в зеркальное отображение с использованием инструментов 
Mirror Horizontal или Mirror Vertical 
 

Щелкните по кнопке Mirror Horizontal (панель Edit), чтобы перевернуть объект на горизонтальной 
оси. 
 
Щелкните по кнопке Mirror Vertical (панель Edit), чтобы перевернуть объект на вертикальной оси. 
 
 

Вы можете зеркально переворачивать объекты на горизонтальной или вертикальной оси, используя 
инструмент Mirror Horizontal или Mirror Vertical. 
 
Как переводить объекты в зеркальное отображение с использованием инструментов 
Mirror Horizontal или Mirror Vertical 
 
1  Выберите объект/ы для зеркального переворачивания. 
 
оригинальный объект          зеркальное отображение по горизонтали (X) 

                                      
зеркальное отображение по вертикали (Y) зеркальное отображение по горизонтали и вертикали (X и Y) 
 
2  Щелкните по значку Mirror Horizontal, чтобы перевернуть объект по горизонтали, или Mirror Vertical,  

чтобы перевернуть объект по вертикали. 
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оригинальный проект 

Зеркальное переворачивание объектов с использованием свойств объекта 
Вы можете зеркально переворачивать объекты по горизонтали или по вертикали, используя диалоговое 
окно Object Properties (Свойства объекта). 
 
Как переворачивать объекты с использованием свойств объекта 
1  Выберите объект/ы для зеркального переворачивания. 
2  Дважды щелкните по объекту, чтобы открыть диалоговое окно Object Properties, и выберите закладку 

General. 
3  На панели Mirror выберите In X или In Y. 

◄ При выборе In X объект перевернется по горизонтали  
◄ При выборе In Y объект перевернется по вертикали. 

 
 

Переворот по горизонтали 
 

Переворот по вертикали 
 

 
Совет: Проставьте флажки в обоих окошках, чтобы одновременно перевернуть объект по горизонтали и 
вертикали. 
4  Нажмите кнопку ОК. 
 
Зеркальное переворачивание с дублированием объектов 

 
Используйте инструмент Mirror Merge Horizontal (панель Arrange) для дублирования объекта по 
горизонтали. 
 
Используйте инструмент Mirror Merge Vertical (панель Arrange) для дублирования объекта по 
вертикали. 
 
Используйте инструмент Mirror Merge Horizontal/Vertical (панель Arrange) для дублирования 
объекта как по горизонтали, так и по вертикали. 
 

Инструменты Mirror-Merge (Зеркальное переворачивание-Дублирование) позволяют дублировать и 
преобразовывать объекты и объединять их в единый объект.  

             
Как зеркально переворачивать и дублировать объекты 
1  Выделите объект/ы. 

Примечание: Убедитесь в том, что исходный объект/ы разгруппированы, в противном случае при 
операции зеркального отображения с дублированием последовательность цветов не будет изменена. 

 
2  Выберите инструмент Mirror-Merge  

 
 
◄ Mirror-Merge Horizontal 

         
 
 
 
 

◄ Mirror-Merge Vertical       



Глава 22: Расположение и трансформация объектов 
 

BERNINA® Embroidery Software Версия 5 310

◄ Mirror-Merge Horizontal/Vertical 
 
3  Переместите базисную линию в положение, в которое вы 

хотите добавить перевернутый объект и щелкните, чтобы 
наметить местоположение анкера. 

 Указатель мыши соединяется с базисной линией. При 
перемещении указателя вокруг объекта, зеркально 
перевернутый объект также перемещается. 

 Копия объекта помещается как зеркально перевернутое изображение оригинала. 
 

Примечание: Если перевернутая копия перекрывает оригинальный объект, то появится вопрос, хотите 
ли вы объединить объекты. 

 
Создание венков 
 

Используйте инструмент Wreath (панель Arrange), чтобы многократно дублировать объекты вокруг 
центральной точки. 
 
Используйте инструмент Kaleidoscope (панель Arrange, чтобы расположить  зеркально 
отображенные объекты вокруг центральной оси. 
 

Инструмент Wreath (Венок) многократно дублирует 
объекты вокруг центральной точки. Инструментом 
Kaleidoscope (Калейдоскоп) работают совместно с 
инструментом Wreath для расположения зеркально 
перевернутых объектов вокруг центральной оси.  
Поскольку объект зеркально переворачивается, функция 
Kaleidoscope действует только с четным количеством 
объектов.          

 

6-точечный венок с              6-точечный венок с  
отключенной функцией Kaleidoscope       включенной  

     функцией   
     Kaleidoscope 

Как создать венок 
1  Выделите объект/ы. 

Примечание: Убедитесь в том, что исходный объект/ы разгруппированы, в противном случае при 
операции зеркального отображения с дублированием последовательность цветов не будет изменена. 

2  Нажмите кнопку Wreath (Венок). 
3  Введите число точек венка.  
 
 Примечание: Для активирования функции Kaleidoscope вводите четные 

числа. 
4  Нажмите кнопку Kaleidoscope, если это необходимо. 
5  Переместите базисную линию к центру венка и щелкните, чтобы наметить 

местоположение анкера. 
 

Совет: Удерживайте нажатой клавишу Ctrl, чтобы линий проходила под 
углом 45°. 

 

Переместите указатель мыши  
для установления центральной точки. 

 

Указатель мыши соединяется с базисной линией. При перемещении указателя вокруг объекта, 
зеркально перевернутый объект также перемещается. 
Объекты копируются и размещаются вокруг центральной точки. 

 

Примечание: Если перевернутая копия перекрывает 
оригинальный объект, то появится вопрос, хотите ли вы 
объединить объекты. 

 
8-точечный венок с центром,  

намеченным ниже оригинального объекта 
      

 
 

8-точечный венок с центром, намеченным выше оригинального объекта 
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Глава 23  
 

 

 

Изменение формы и правка 
объектов 
 
BERNINA Embroidery Software позволяет изменять форму объекта, угла 
стежков точки входа и выхода с помощью контрольных точек. Линии 
наклона стежков маркеры входа и выхода появляются вокруг 
выбранных объектов. Контрольные точки слегка различаются в 
зависимости от типа объекта. 
Рекомендуется перед началом изменения любого проекта сохранить 
его копию под новым именем и хранить оригинал для случая, если вы 
захотите отказаться от всех изменений и начать снова. 
В этом разделе объясняется, как изменять форму объектов 
контрольными точками, изменять форму окружностей, устанавливать 
угол наклона стежков – включая сложные углы наклона – и изменять точки входа и выхода. См. 
также раздел Правка вышиваемых текстов. 
 

Изменение формы объектов 
Вы можете изменять форму объекта, выбрав его инструментом Reshape Object (Изменение формы 
объекта) и перемещая, добавляя или удаляя контрольные точки на контуре. Для некоторых объектов вы 
можете также заменять угловые контрольные точки на контрольные точки кривых. 
Инструмент Reshape дает возможность изменять формы, не оказывая влияния на угол стежков. 
 
Примечание: Стежки всех объектов при изменении формы регенерируются. 
 
Просмотр и выбор контрольных точек 
 

 
Используйте инструмент Reshape Object (панель Edit) для просмортра контрольных точек 
выбранных объектов. 
 

Узлы изменения формы могут быть выбраны индивидуально или совместно для изменения положения 
или модификации. 
 
Просмотр и выбор контрольных точек 
 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Вокруг объекта появятся контрольные точки - узлы изменения формы.  
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точка выхода 
 
 
контрольная точка кривой 
 
 
 
угловая контрольная точка 
 
 
 
 
 
точка входа 
 
 

3  Для выделения выполните одну из следующих операций: 
Выбранная контрольная точка изменения формы "подсвечивается". 

 
◄ Щелкните, чтобы выбрать отдельную  контрольную точку. 

 
◄ Удерживая клавишу Ctrl, щелкните, чтобы выбрать несколько контрольных точек.  

 
◄ Щелкните и обведите ограничивающий прямоугольник вокруг группы контрольных точек, чтобы 

выбрать их. 

           
Изменение формы объектов с использованием контрольных точек 

 
Используйте инструмент Reshape Object (панель Edit) для изменения формы объекта. 
 

Вы можете изменять форму объекта, выбрав его инструментом Reshape Object (Изменение формы 
объекта) и перемещая, добавляя или удаляя контрольные точки на контуре. Для некоторых объектов вы 
можете также заменять угловые контрольные точки на контрольные точки кривых. 
 
Как изменять формы объектов с использованием контрольных точек 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Вокруг объекта появятся контрольные точки. 
 
3  Для создания дополнительных контрольных точек 

изменения формы на контуре: 
◄ щелкните левой кнопкой (Left-click), чтобы добавить 

угловую точку, 
◄ щелкните правой кнопкой (Right-click), чтобы добавить 

точку кривой. 
 
 

4  Выберите требуемые узлы изменения формы. Подробнее 
см. в разделе Просмотр и выбор узлов изменения формы. 

 
 
Перемещение контрольных точек 
Вы можете перемещать контрольные точки, чтобы изменить форму контура. 
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Перетащите и нажмите Enter 

Выберите Delete  и нажмите Enter 

Выберите, нажмите  клавишу пробела   
и нажмите Enter 

 
5  Определите новое положение выбранных узлов 

изменения формы, перетащите их вдоль контура и 
нажмите клавишу Enter.  

 
Совет: Используйте клавиши со стрелками для 
"подталкивания" выбранных узлов изменения формы. 

 
 
 
 
 
6  Нажмите Delete для удаления нежелательных узлов 

изменения формы и нажмите Enter. 
 
 
 
 
 
 
 
 
 
7  Нажимайте клавишу пробела, чтобы переходить от 

выбранных угловых точек к точкам кривой и затем клавишу 
Enter. 
Совет: Если вы сделали ошибку, нажмите Esc, чтобы 
отменить изменения, нажмите Esc еще раз, чтобы 
деактивировать инструмент Reshape Object.  

 
Примечание: Вы можете также настроить по своему желанию 
угол наклона стежков, как и изменять точки входа и выхода. 
Подробнее см. в разделах Подгонка  
углов наклона стежков и Изменение точек входа и выхода. 
 
8  Нажмите Esc для завершения. 
 
Изменение формы следующего или предыдущего объекта 
При правке объекта в режиме Reshape используйте клавишу табуляции (Tab) для быстрого перехода 
между объектами. См. также раздел Отмена выделения объектов. 
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Как измененять форму следующего или предыдущего объекта 
◄ Нажмите клавишу Tab для принятия всех изменений и перехода к следующему в последовательности 

вышивания объекту. 

 
 
◄ Нажатие клавиш Shift + Tab приводит к принятию всех изменений объекта и к переходу к 

предыдущему объекту. 
 
    

Изменение формы объектов окружности 
 
Используйте инструмент Reshape Object (панель Edit) для изменения формы объектов окружности. 
 
 

Для объектов, созданных инструментом Circle (Окружность), 
изменение формы производится только контрольными точками. В 
таких объектах вы не можете добавлять, изменять или удалять 
контрольные точки. Объекты окружности можно преобразовывать из 
окружности в овал инструментом Reshape Object. Объекты 
окружности имеют две контрольные точки изменения формы 
(используемые для изменения радиуса и ориентации объекта), 
центральную точку (используемую для изменения положения) и точку 
входа стежка. 

контрольная точка 
    
 

 
 

угол стежка 
 
 
 
точка входа 

контрольная точка изменения формы 
 
 
 
          точка центра  

   
 Как изменять форму объектов окружности 
1  Выберите объект окружности и нажмите кнопку Reshape Object (Изменение формы объекта). 
 Вокруг объекта появятся контрольные точки. 
 
 
 Совет: Для перемещения окружности щелкните по контрольной точке в центре окружности и 

перетащите ее в новое положение. 
3  Щелкните по контрольной точке на контуре окружности и перетащите ее для изменения формы  
      контура. 

◄ Для изменения формы без изменения ориентации 
используйте контрольную точку на вершине объекта. 
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◄ Для изменения формы и вращения объекта вокруг 

центральной точки используйте боковую контрольную 
точку. 

        
 

 
 
 

 
         
4  Нажмите Enter, чтобы принять изменения и клавишу Esc для окончания. 
 
 

Совет: Для изменения размера окружности без превращения ее в овал выберите ее инструментом 
Select Object (Выбор объекта) и используйте угловые маркеры 
выделения, чтобы изменить размер. 
 
 
 
 
 
Изменение размера с  
использованием угловых  
маркеров выделения 
 
 
 
 

Изменение формы цепочки узоров 
 

 
Используйте инструмент Reshape Object (панель Edit) для просмотра контрольных точек 
выбранных объектов. 
 

Форма цепочки узоров изменяется инструментом Reshape (Изменение формы) таким же образом, как вы 
изменяете форму текстовых объектов. 
Вы можете сделать цепочку узоров выше или уже, поворачивать цепочку узоров, перемещать 
индивидуальные узоры по базовой линии или изменять форму базовой линии. Вы можете поворачивать, 
наклонять и переводить в зеркальное отображение цепочку узоров таким же образом, как и другие 
объекты. 
 
Как изменять форму цепочки узоров 
1  Выберите цепочку узоров и щелкните по 

значку Reshape. 
Вокруг объекта появятся узлы изменения 
формы.  

2  Перетащите контрольные точки изменения 
формы, чтобы изменить внешний вид 
цепочки узоров. 

3  Нажмите Esc для завершения. 
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Подгонка углов наклона стежков 
 
Настройка угла наклона стежков зависит от типа объекта, с которым вы работаете. Для заполняемых 
объектов вы можете назначить угол наклона стежка для всего объекта. Альтернативно вы можете 
добавить сложные углы наклона стежков инструментом Stitch Angles. Вы можете также установить угол 
наклона стежка, используйте инструмент Reshape Object. 
 
Примечание: Вы можете изменить угол наклона стежков объекта окружности, перемещая точку ввода 
стежков. 
 
Подгонка углов наклона стежков с использованием свойств объекта 
Вы можете изменить угол наклона стежка заполняемых объектов, используя свойства объекта. 
 

       
Как подогнать углы наклона стежков с использованием свойств объекта 
1  Выберите объект и дважды щелкните по нему или щелкните 

правой кнопкой мыши. 
 Откроется диалоговое окно Object Properties (Свойства 

объекта). 
2  Выберите закладку Stitch Angle (Угол наклона стежка).  
 
 

Введите требуемый угол наклона стежка 
3  В поле Angle (Угол) введите требуемый угол наклона стежка. 

       
Угол: 90°       Угол: 0° 

4  Нажмите кнопку Apply. 
Подгонка углов наклона стежков на экране 

 
Используйте инструмент Reshape Object (панель Edit) для установки угла наклона стежков 
выбранных объектов. 
 

Вы можете изменить угол наклона стежка объектов, используя функцию Reshape Object (Изменение 
формы объекта). 
 
Как подогнать углы наклона стежков на экране 
1  Выберите объект с заполнением. 
2  Нажмите кнопку Reshape Object 

(Изменение формы объекта). 
 Появятся контрольные точки вместе с 

линией угла наклона стежков. 
        
3  Перетащите мышью эту линию, как 

вам требуется. 
 
 Совет: При перемещении указателя 

мыши над точкой угла наклона на 
экране появляется всплывающая 
подсказка с углом наклона стежков 
выбранного объекта.       Угол 0°       Угол 90°  
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измененные углы 
наклона стежков 

4  Нажмите Enter, чтобы принять изменения и клавишу Esc для окончания. 
 
 Совет: Для установки точного угла наклона стежков используйте свойства объекта. Подробнее см. в 

разделе Подгонка углоа наклона стежка с использованием свойств объекта. 
 
Настройка сложных углов наклона стежков 

 
Используйте инструмент Stitch Angles (панель Stitch and Color), чтобы настроить сложные углы 
наклона стежков для новых или выбранных объектов. 
 

Углы наклона стежков объектов с заполнением все модифицируются тем же способом. Сложные углы 
наклона стежков могут быть добавлены инструментом Stitch Angles.  

             
одинаковый угол наклона стежков       сложные углы наклона стежков 

 
Совет: Инструментом Reshape (Изменить форму) вы можете добавить индивидуальные контрольные 
точки без воздействия на углы наклона стежков. Подробнее см. в разделе Изменение формы объектов. 
 
Как настраивать сложные углы наклона стежков 
1  Выберите объект с заполнением. 

 
2  Нажмите кнопку Reshape Object (Изменение формы 

объекта).  
 Появятся контрольные точки вместе с линией угла 

наклона стежков. 
 
 
3  Щелкните по значку Stitch Angles. 
 Вам будет предложено ввести углы наклона стежков.  
 
4  Назначьте такие углы наклона – точки 1 и 2 - , чтобы стежки 

пересекали две стороны объекта. Убедитесь в том, что они 
не пересекают друг друга. 

    
 

введенные углы наклона стежков 
 
Внимание: Новые линии стежков не должны пересекать 
существующие линии стежков, в противном случае появится 
сообщение об ошибке. Нажмите клавишу пробела Backspace для удаления. 
5  Вводите точки угла столько раз, сколько требуется для создания эффекта "переворачивания" 

заполнения. 
6  Выберите и подгоните контрольные точки для изменения формы объекта по своему желанию. 
 
7  Нажмите Enter, чтобы принять изменения и клавишу Esc для окончания. 

Стежки объекта оцифровываются заново с новыми углами. 
    

     
 
Подгонка сложных углов наклона стежков 

 
Используйте инструмент Reshape Object (панель Edit) для подгонки  сложных углов наклона 
стежков. 
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подогнанные углы 
наклона стежков 

 
BERNINA Embroidery Software позволяет подгонять сложные углы наклона стежков оцифровываемых 
объектов. 
 

Как подгонять сложные углы наклона стежков 
1  Выберите объект с заполнением. 
          

2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Появятся контрольные точки вместе с линией угла наклона стежков. 

 
3  Назначьте углы наклона. Подробнее см. в разделе Подгонка углов наклона стежков на экране. 
 
4  Нажмите Enter, чтобы принять изменения и клавишу Esc для 

окончания. 
Стежки объекта оцифровываются заново с новыми углами. 

 
 

Подгонка точек входа и выхода 
 

Используйте инструмент Reshape Object (панель Edit) для подгонки  точек входа и выхода 
выбранных объектов. 
 

По умолчанию функция Closest Join (Самое короткое соединение) автоматически рассчитывает 
кратчайшее соединение между объектами, экономя ваше время, требуемое для нахождения точек входа и 
выхода. Вкладка Settings > Options > General позволяет при необходимости деактивировать эту 
функцию. Если эта функция деактивирована, все вновь оцифровываемые объекты соединяются методом 
As Digitized (По мере оцифровки). Это означает, что во время оцифровки вам будет предлагаться 
выбирать точки входа и выхода. Вы сможете изменять их в любое время инструментом Reshape Object. 
См. также Настройка других общих опций. 
 
Как изменять точки входа и выхода 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Появятся контрольные точки, включая точки входа и выхода. 

 
   точка выхода 

             
 
 
 

 
точка входа 

 
 

     длинный  
переходной  

      стежок 
       
 

Примечание: В объектах окружности появляется точка входа. 
3  Выберите точку входа или выхода, как вам нужно, и перетащите ее в другое положение на контуре 

объекта. 
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4  Нажмите Enter, чтобы принять изменения и клавишу Esc для окончания. 
 
 
 
 
 
           

точка входа    
 

точка  
выхода 

  
 
 
 
 
Примечание: В объектах окружности угол наклона стежков перпендикулярен линии, соединяющей точку 
входа с центром окружности. Таким образом, при изменении точки входа стежка в объекте окружности 
изменяется угол наклона стежка. 
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Глава 24 
 
 
 
 
 
 
 
 
 
 
 
 

Редактирование стежков 
 
BERNINA Embroidery Software автоматически генерирует стежки 
в соответствии с контуром проекта и его свойствами. Это 
означает, что вы можете преобразовывать проекты BERNINA 
artista и изменять их формы без изменения плотности или 
качества стежков. 
Но BERNINA Embroidery Software позволяет также 
редактировать индивидуальные стежки. Вам просто нужно 
выбрать стежок, как и любой другой объект, и переместить по 
своему желанию точку укола иглой. Например, вы можете 
вставлять стежки в объект, чтобы заполнить пробелы. Вы 
можете переместить или удалить индивидуальные стежки или 
группы выбранных стежков. 
В частности, это может потребоваться при работе с файлами стежков, которые не содержат 
данных о контуре проекта. Однако, если это возможно, редактируйте свойства объекта раньше, 
чем индивидуальные стежки. См. также Форматы проектов вышивки. 
В этом разделе объясняется, как выбирать и редактировать стежки. 
 

Выбор стежков 
 
Функция Stitch Edit (Редактирование стежков) позволяет выбирать отдельные стежки или диапазон 
стежков путем выбора их точек укола иглой или оконтуривающим прямоугольником. Выбранные стежки 
выделяются другим цветом. 
 
Выбор стежков по точке укола иглой 
 
Используйте команду Stitch Edit (меню Edit), чтобы выбрать индивидуальные стежки для редактирования. 
 
Вы можете выбрать индивидуальные стежки в режиме Stitch Edit (Редактирование стежка) путем выбора 
их точек укола иглой. 
 
Совет: Увеличьте масштаб изображения, чтобы можно было легче выбирать точки укола иглой. 
 
Как выбирать стежки по точке укола иглой 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы перейти в режим Stitch Edit. 
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2 Щелкните по точке укола иглой. 
Цвет точки укола иглой изменится, а маркер положения иглы переместится на выбранный стежок. Все 
стежки за маркером положения иглы в последовательности вышивания будут отображены черным 
цветом. 

     выбранный стежок   Удерживайте клавишу Shift,  
чтобы выбрать диапазон стежков 
 
 
 
 
 
 
 
 
 
 

 
Для выбора диапазона стежков удерживайте нажатой клавишу Shift. 
◄ Для выбора нескольких стежков удерживайте нажатой клавишу Ctrl. 

 
Выбор стежков ограничивающим прямоугольником 
 
Используйте команду Stitch Edit (меню Edit), чтобы выбрать стежки ограничивающим прямоугольником. 
 
Вы можете быстро выбрать все стежки в группе, обведя вокруг него ограничивающий прямоугольник. 
 
Как выбирать стежки ограничивающим прямоугольником 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы перейти в режим Stitch Edit. 
 
2 Очертите указателем мыши ограничивающий прямоугольник вокруг выделяемых стежков. 

Стежки будут выделены, как только вы отпустите кнопку мыши. 

                
ограничивающий прямоугольник  стежки выделены 

Вставка стежков 
Используйте команду Stitch Edit (меню Edit), чтобы вставить стежки в объект. 
 
Вы можете вставлять стежки в объект, чтобы заполнить пробелы. Вставленные стежки являются 
обоснованной частью объекта (в большей мере, чем независимые объекты). Однако они могут быть 
удалены, если происходит регенерация стежков. Если это возможно, лучше редактируйте свойства 
объекта, чем индивидуальные стежки. Например, чтобы увеличить плотность стежков, лучше уменьшить 
интервал между стежками. чем вставлять стежки. 
 
Как вставлять стежки 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы перейти в режим Stitch Edit. 
 
 Увеличьте масштаб изображения той зоны, которую вы хотите редактировать. 
2 Выберите точку укола иглой. 

      
 

Цвет стежка изменится, а маркер положения иглы переместится на выбранный стежок. Все стежки за 
маркером положения иглы в последовательности вышивания будут отображены черным цветом. 
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3 Переместите указатель мыши в то место, куда вы хотите вставить стежок, и щелкните правой кнопкой 
мыши. 

             
Щелкните правой кнопкой мыши, чтобы вставить новый стежок 

 
5  Переместите мышь в то место, куда вы хотите вставить стежок, и щелкните правой кнопкой мыши. 

          
Щелкните правой кнопкой мыши, чтобы вставить новый стежок 

 
6  Продолжайте щелкать правой кнопкой мыши по мере необходимости. 
 

Перемещение стежков 
 
Используйте команду Stitch Edit (меню Edit), чтобы выбрать индивидуальные стежки для перемещения. 
 
Вы можете перемещать индивидуальные стежки или группы стежков. 
 
Внимание: Если стежки объекта по любой причине регенерируются, все функции редактирования стежков 
теряются. Если это возможно, лучше изменять форму объекта, чем перемещать индивидуальные стежки. 
Подробнее см. в разделе Изменение формы и правка объектов. 
 
Как перемещать стежки 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы перейти в режим Stitch Edit. 
 
 Увеличьте масштаб изображения той зоны, которую вы хотите редактировать. 
 
2 Выберите стежки и перетащите их мышью в новое положение. 

Новое положение будет отображено теневым контуром. 
 
 
Перетащите стежок  
в новое положение 
 
выбранные стежки 
теневой контур 
 
3 Нажмите Enter. 

Удаление стежков 
 
Используйте команду Stitch Edit (меню Edit), чтобы выбрать индивидуальные стежки для удаления. 
 
Вы можете удалять индивидуальные стежки или группы стежков. 
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Внимание: Если стежки объекта по любой причине регенерируются, все функции редактирования стежков 
теряются. Если это возможно, лучше редактируйте свойства объекта, чем индивидуальные стежки. 
Подробнее см. в разделах Регулировка шага гладьевого заполняющего стежка и Сохранение длинных 
стежков функцией Auto Jump. 
 
Как удалять стежки 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы перейти в режим Stitch Edit. 
  
Увеличьте масштаб изображения той зоны, которую вы хотите редактировать. 
 
2 Выберите стежок или стежки 
3 Нажмите клавишу Delete. 
              

 
 

 
 
 
 
 
 
 
 
 
 
 

 
стежки выделены         стежки удалены 


